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Preparing for installation

The HP 1920 Gigabit Ethernet Switch Series includes models listed in Table 1.
Table 1 HP 1920 Gigabit Ethernet Switch Series models

Product code  HP description Alias RMN

Non-PoE

JG920A HP 1920-8G Switch 1920-8G HNGZA-HAO0008
JG923A HP 1920-16G Switch 1920-16G HNGZA-HAOO011
JG924A HP 1920-24G Switch 1920-24G HNGZA-HA0012
JG927A HP 1920-48G Switch 1920-48G HNGZA-HAO0015
JG921A HP 1920-8G-PoE+ (65W) Switch 1920-8G-PoE+ (65W) HNGZA-HAO009
JG922A HP 1920-8G-PoE+ (180W) Switch 1920-8G-PoE+ (180W) HNGZA-HAO0010
JG925A HP 1920-24G-PoE+ (180W) Switch ~ 1920-24G-PoE (180W) HNGZA-HAO0013
JG926A HP 1920-24G-PoE+ (370W) Switch ~ 1920-24G-PoE (370W) HNGZA-HA0014

(® IMPORTANT:

For regulatory identification purposes, the switches are assigned Regulatory Model Numbers (RMN). The
RMNS should not be confused with the marketing name HP 1920, or the product codes.

Safety recommendations

To avoid any equipment damage or bodily injury, read the following safety recommendations before
installation. The recommendations do not cover every possible hazardous condition.

To avoid damage to the electrolytic capacitor in the switch, do not store the switch without power for
more than one year.

Before cleaning the switch, remove all power cords from the switch. Do not clean the switch with a
wet cloth or liquid.

Do not place the switch near water or in a damp environment. Prevent water or moisture from
entering the switch chassis.

Do not place the switch on an unstable case or desk. The switch might be severely damaged in case
of a fall.

Ensure good ventilation of the equipment room and keep the air inlet and outlet vents of the switch
free of obstruction.

Make sure the operating voltage is in the required range.

To avoid electrical shocks, do not open the chassis while the switch is operating or when the switch
is just powered off.



e The accessories shipped with the switch, including but not limited to power cables, are intended
only for the switch. Please do not use them for other products.

Examining the installation site

The switches must be used indoors. You can mount your switch in a rack or on a workbench, but make
sure:

e A minimum clearance of 5 cm (1.97 in) is reserved at the air inlet and exhaust vents for ventilation.
e The rack or workbench has a good ventilation system.
e The rack or workbench is sturdy enough to support the switch and its accessories.

e The rack or workbench is reliably grounded.

To ensure correct operation and long service life of your switch, install it in an environment that meets the
requirements described in the following subsections.

Temperature/humidity

Maintain temperature and humidity in the equipment room as described in "Environmental
specifications."

e Llasting high relative humidity can cause poor insulation, electricity creepage, mechanical property
change of materials, and metal corrosion.

e Llasting low relative humidity can cause washer contraction and ESD and bring problems including
loose captive screws and circuit failure.

e High temperature can accelerate the aging of insulation materials and significantly lower the
reliability and lifespan of the switch.

Cleanness

Dust buildup on the chassis might result in electrostatic adsorption, which causes poor contact of metal
components and contact points, especially when indoor relative humidity is low. In the worst case,
electrostatic adsorption can cause communication failure.

Table 2 Dust concentration limit in the equipment room

Substance Concentration limit (particles/m?3)
Dust < 3 x 10*(no visible dust on the tabletop over three days)
NOTE:

Dust diameter = 5 pm

The equipment room must also meet strict limits on salts, acids, and sulfides to eliminate corrosion and
premature aging of components, as shown in Table 3.

Table 3 Harmful gas limits in the equipment room

Gas Maximum concentration (mg/m?)
SO, 0.2
H,S 0.006




EMI

Gas Maximum concentration (mg/m?)

NH, 0.05

cl, 0.01

All electromagnetic interference (EMI) sources, from outside or inside of the switch and application
system, adversely affect the switch in the following ways:

A conduction pattern of capacitance coupling.
Inductance coupling.
Electromagnetic wave radiation.

Common impedance (including the grounding system) coupling.

To prevent EMI, use the following guidelines:

It AC power is used, use a single-phase three-wire power receptacle with protection earth (PE) to
filter interference from the power grid.

Keep the switch far away from radio transmitting stations, radar stations, and high-frequency
devices.

Use electromagnetic shielding when necessary. For example, use shielded interface cables.



Installing the switch

A WARNING!

Before installing or moving the switch, remove the power cord.

You can install an HP 1920 switch in a 19-inch rack, on a workbench, or on a wall.

Mounting the switch in a 19-inch rack by using
mounting brackets

Wear an ESD wrist strap and make sure it makes good skin contact and is reliably grounded.
Verify that the rack is securely grounded and is stable.

Select mounting brackets for the switch.

o The HP 1920-8G switch uses Type-A mounting brackets, as shown in Figure 1.

o The HP 1920-8G-PoE+ (65W) and 1920-8G-PoE+ (180W) switches use Type-B mounting
brackets, as shown in Figure 2.

o The HP 1920-16G, 1920-24G, 1920-24G-PoE+ (180W), 1920-24G-PoE+ (370W) and
1920-48G switches use Type-C mounting brackets, as shown in Figure 3.

4.  Attach the mounting brackets to both sides of the chassis with screws.

NOTE:

Mounting brackets are used only for securing the switch to the rack. A rack shelf on the rack is used
to bear the switch weight.

Figure 1 Attaching Type-A mounting brackets to the switch
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Figure 2 Attaching Type-B mounting brackets to the switch
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Figure 3 Attaching Type-C mounting brackets to the switch
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Place the switch on a rack shelf in the rack. Push the switch in until the oval holes in the brackets
align with the mounting holes in the rack posts.

6.  Attach the mounting brackets to the rack posts with screws.

Figure 4 Attaching Type-A mounting brackets to the rack post




Figure 5 Attaching Type-B mounting brackets to the rack post

Figure 6 Attaching Type-C mounting brackets to the rack post




Mounting the switch on a workbench

(D IMPORTANT:
o Reserve a clearance of 10 cm (3.9 in) around the chassis for heat dissipation.

o Do not place heavy objects on the switch.

To mount the switch on a workbench:

1. Verify that the workbench is sturdy and reliably grounded.

2. Place the switch bottom up, and clean the round holes in the chassis bottom with a dry cloth.
3. Attach the rubber feet to the four round holes in the chassis bottom.

4.  Place the switch upside up on the workbench.

Figure 7 Attaching rubber feet (HP 1920-24G-PoE+ Switch)
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Mounting the switch on a wall

Only the HP 1920-8G switch can be installed on a wall. The type of screws used to mount the switch on
the wall depends on the wall type. This section uses a concrete wall as an example.

Wall-mounting anchor kits are user supplied. The screws must be a minimum of 3 mm (0.12 in) in
diameter, and the screw head must be a minimum of 6 mm (0.24 in) in diameter.

Figure 8 Wall-mounting anchor kit

To install the switch on a concrete wall:

1. Dirill two holes at the same height. Make sure the spacing in between is 160 mm (6.30 in), as
shown in Figure 9.

The hole depth and diameter depend on the wall anchors and screws you use. Make sure you can
push the anchors to their full depth in the holes.



Figure 9 Hole spacing

772 + Xmm

Insert one wall anchor into each hole until the anchors are flush with the wall surface.

Drive one screw into each wall anchor, and tighten the screws just enough to keep it secure in the
wall anchor.

Leave a minimum clearance of 1.5 mm (0.06 in) between the base of the screw head and the wall
anchor so the switch can hang on the screws securely.

Figure 10 Driving a screw into a wall anchor
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Align the two mounting holes in the switch chassis bottom with the two screws on the wall and
hang the switch.

Make sure the Ethernet ports are facing downwards and the chassis side panels are perpendicular
to the ground.

Figure 11 Wall mounting
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o000 000
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(1) Mounting hole in the switch chassis bottom




Connecting cables

Connecting network cable

Use crossover cable or straight through cable to connect a PC or other network devices to the Ethernet
port of the switch.

Figure 12 Connecting network cable

Installing the SFP transceiver module and optical fibers

/\ CAUTION:

o Hold the SFP transceiver module by its two sides when you install or remove the module. Do not touch
the golden finger of the module.

o Remove the optical fiber, if any, from a transceiver module before installing it.

To install an SFP transceiver module and optical fibers:
1. Wear an ESD wrist strap and make sure it makes good skin contact and is reliably grounded.

2. Pivot the clasp of the module up. Holding the module, gently push the module into the slot until it
has firm contact with the slot (when the top and bottom spring tabs catch in the slot).

3. Remove protective sleeves from optical fibers, and the dust plug from the transceiver module.

Connect the LC connectors of the optical fibers to the transceiver module.

NOTE:

Keep the protective sleeves for future use.




Figure 13 Installing the SFP transceiver module and optical fibers

Connecting the console cable

To connect a terminal (for example, a PC) to the switch:
1. Wear an ESD wrist strap and make sure it makes good skin contact and is reliably grounded.
2. Connect the DB-9 female connector of the console cable to the serial port of the PC.

3. Connect the RJ-45 connector to the console port of the switch.

Figure 14 Connecting the console cable

NOTE:

To disconnect the console cable, remove the RJ-45 connector of the cable and then the DB-9 female
connector.

Connecting the AC power cord

Wear an ESD wrist strap and make sure it makes good skin contact and is reliably grounded.

2. Connect one end of the grounding cable to the grounding screw on the rear panel, and connect
the other end to the ground.

3. Make sure the correct power source is used.

10



4.  Connect one end of the AC power cord to the AC power receptacle on the switch.
5. Connect the other end of the AC power cord to the AC power outlet.

6. Examine the power LED. If it is ON, the power connection is correct.

Figure 15 Connecting the AC power cord to the AC power receptacle

Connecting the DC power cord

(D IMPORTANT:
Make sure the DC power cord is shorter than 3 m (9.84 fi).

Only the HP 1920-24G-PoE+ (370W) supports DC RPS power.

If only the DC power cord is connected, the switch operates correctly when the DC input voltage is in the
range of —47 VDC to -57 VDC. If both AC and DC power cords are connected, the switch chooses the
power supply based on the DC input voltage, as shown in Table 4.

Table 4 Power supply selection criteria

DC input voltage Power supply
-54 VDC to =57 VDC DC
< -54 VDC AC

To connect the DC power cord:
1. Wear an ESD wrist strap and make sure it makes good skin contact and is reliably grounded.

2. Connect one end of the grounding cable to the grounding screw on the rear panel, and connect
the other end to the ground.

3. Insert the DC connector to the DC power receptacle.

If you cannot insert the connector into the receptacle, do not force it. Re-orient the connector and
try to insert it again.

Use a flathead screwdriver to fasten screws on both sides of the connector.

5. Connect the other end of the DC power cord to the RPS. Make sure the RPS is supplying a minimum
of 876 W power.

6. View the RPS LED to verify that the DC power cord is installed correctly.

11



Figure 16 Connecting the DC power cord to the DC power receptacle

Veritying the installation

After you complete the installation, verity the following items:

There is enough space for heat dissipation around the switch.
The rack or workbench is stable.

The grounding cable is securely connected.

The correct power source is used.

The power cords are correctly connected.

All the interface cables are cabled indoors. If any cable is routed outdoors, verify that the socket
strip with lightning protection and lightning arresters for network ports have been correctly
connected.

12



Accessing the switch for the first time

Setting up the configuration environment

The first time you access the switch you must use a console cable to connect a console terminal, for
example, a PC, to the console port on the switch.

Figure 17 Connecting the console port to a terminal

Connecting the console cable

Console cable

A console cable is an 8-core shielded cable. It has a crimped RJ-45 connector at one end for connecting

to the console port of the switch, and a DB-9 female connector at the other end for connecting to the
serial port on the console terminal.

Figure 18 Console cable

A side

Main label

B side
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Connection procedure

/\ CAUTION:

The serial ports on PCs do not support hot swapping. To connect a PC to an operating switch, first connect
the PC end. To disconnect a PC from an operating switch, first disconnect the switch end.

To connect a terminal (for example, a PC) to the switch:

1.
2.
3.

Wear an ESD wrist strap and make sure it makes good skin contact and is reliably grounded.
Connect the DB-9 female connector of the console cable to the serial port of the PC.
Connect the RJ-45 connector to the console port of the switch.

Identify the mark on the console port and make sure you are connecting to the correct port.

Setting terminal parameters

To configure and manage the switch, you must run a terminal emulator program on the console terminal.

The following terminal settings are required:

Bits per second—38400.

Data bits—8.
Parity—None.
Stop bits— 1.

Flow control—None.
Emulation—VT100.

To set terminal parameters (for example, on a Windows XP HyperTerminal):

1.

Select Start > All Programs > Accessories > Communications > HyperTerminal.
The Connection Description dialog box appears.

Enter the name of the new connection in the Name field and click OK.

Figure 19 Connection description

Connection Description 2=

Enter a name and chooze an ican far the connection:

M ame:
ISwitcH

lcon:

Cancel |
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3. Select the serial port to be used from the Connect using list, and click OK.

Figure 20 Setting the serial port used by the HyperTerminal connection

& Switch

Enter detailz for the phone number that you want to dial;

Courtmregion; ILlniteu:I States of America [1] j

Area code: oo

Phone number: I

Copnect using:
| 0k, I Cancel |

4. Set Bits per second to 38400, Data bits to 8, Parity to None, Stop bits to 1, and Flow control to
None, and click OK.

Figure 21 Setting the serial port parameters

Port Settings I

Bits per zecond: I 33400 j

Drata bits: IE j

Parity: I Mone j

Stap bits: |1 =l

Flaws control: |IREE -

Restore Defaultz |

| ak. I Cancel | Smply |

5. Select File > Properties in the HyperTerminal window.
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6.

Figure 22 HyperTerminal window

“g Switch - HyperTerminal - |EI|1|
File Edit WYiew Call Transfer Help
C
LI
Connected 0:00:03 |Aut0detect |Aut0detect |SCROLL |CAPS |NL|M |Capture |Printech0 Y

On the Settings tab, set the emulation to VT100 and click OK.

Figure 23 Setting terminal emulation in Switch Properties dialog box

Switch Properties ilil
Connect To Settings |

— Function, arrovw, and chil keys act az
7 windows keps

— Backspace kep sends
o Cil+H © Del  Cil+H, Space, Ctil+H

E mulation;
YT100 =] Teminal Setup... |

Telnet terminal ID: ~ [¥T100

Backscrall buffer lines: IEEIEI :I

[T Play sound when conrecting or disconnecting

Input Translation. .. | ASCI Setup... |

] I Cancel |
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Powering on the switch

Verification before power-on

Before powering on the switch, verify the following items:

e The power cord is correctly connected.

e The input power voltage meets the requirement of the switch.
e  The console cable is correctly connected.

e The terminal (for example, a PC) has started, and its configuration parameters have been correctly
set.

Powering on the switch

Power on the switch (for example, an HP 1920-24G switch), and the following information is displayed:

Starting......

* *
* HP 1920-24G Switch JG924A BootWare, Version 1.09 *

* *

* * * * * * * * * * *

Copyright (c) 2010-2014 Hewlett-Packard Development Company, L.P.

Compiled Date : Mar 20 2014 17:00:53
CPU Type > MIPS4kec

CPU L1 Cache : 16KB

CPU Clock Speed : 500MHz

Memory Type - DDR3 SDRAM

Memory Size : 128MB

Memory Speed : 300MHz

BootWare Size - 3MB

Flash Size : 32MB

BootWare Validating. ..
Press Ctrl+B to enter extended boot menu...



System application is starting...

User interface aux0O is available.

Press ENTER to get started.

Press Enter and the system displays the following prompt:
<Hp>
This prompt indicates that the switch is ready to configure.

18



Support and other resources

Contacting HP

For worldwide technical support information, see the HP support website:

http://www.hp.com/support

Before contacting HP, collect the following information:

e Product model names and numbers

e Technical support registration number (if applicable)
e Product serial numbers

e Error messages

e Operating system type and revision level

o Detailed questions

Subscription service

HP recommends that you register your product at the Subscriber's Choice for Business website:

http://www.hp.com/go/wwalerts

After registering, you will receive email notification of product enhancements, new driver versions,
firmware updates, and other product resources.

Related information

Documents

To find related documents, browse to the Manuals page of the HP Business Support Center website:

http://www.hp.com/support/manuals

e For related documentation, navigate to the Networking section, and select a networking category.

o For a complete list of acronyms and their definitions, see HP FlexNetwork Technology Acronyms.

Websites

e  HP.com http://www.hp.com

e HP Networking http://www.hp.com/go/networking

e HP manuals http://www.hp.com/support/manuals

e  HP download drivers and software http://www.hp.com/support/downloads

e HP software depot http://www.software.hp.com

e  HP Education hitp://www.hp.com/learn

19
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Conventions

This section describes the conventions used in this documentation set.

Command conventions

Convention Description
Boldface Bold text represents commands and keywords that you enter literally as shown.
Italic ltalic text represents arguments that you replace with actual values.

[ Square brackets enclose syntax choices (keywords or arguments) that are optional.

Braces enclose a set of required syntax choices separated by vertical bars, from which

eyl you select one.

X1yl ] Square brackets enclose a set of optional syntax choices separated by vertical bars, from
vl which you select one or none.

X1yl o1* Asterisk-marked braces enclose a set of required syntax choices separated by vertical
LA bars, from which you select at least one.

[xy|..1* Asterisk-marked square brackets enclose optional syntax choices separated by vertical
Yol bars, from which you select one choice, multiple choices, or none.

&<ln> The argument or keyword and argument combination before the ampersand (&) sign can

be entered 1 to n times.
# A line that starts with a pound (#) sign is comments.

GUI conventions

Convention Description

Window names, button names, field names, and menu items are in bold text. For
Boldface . .

example, the New User window appears; click OK.
> Multi-level menus are separated by angle brackets. For example, File > Create > Folder.

Symbols

Convention Description

An alert that calls attention to important information that if not understood or followed can
A WARNING : .

result in personal injury.

An alert that calls attention to important information that if not understood or followed can
A caution

result in data loss, data corruption, or damage to hardware or software.

@ IMPORTANT An alert that calls attention to essential information.

NOTE An alert that contains additional or supplementary information.

Q TIP An alert that provides helpful information.

20



Network topology icons

Represents a generic network device, such as a router, switch, or firewall.

Represents a routing-capable device, such as a router or Layer 3 switch.

Represents a generic switch, such as a Layer 2 or Layer 3 switch, or a router that supports
Layer 2 forwarding and other Layer 2 features.

Represents an access controller, a unified wired-WLAN module, or the switching engine
on a unified wired-WLAN switch.

Represents an access point.

000066

Represents a mesh access point.

Represents omnidirectional signals.

Represents directional signals.

Represents a security product, such as a firewall, UTM, multiservice security gateway, or
load-balancing device.

¢ )

Represents a security card, such as a firewall, load-balancing, NetStream, SSL VPN, IPS,
or ACG card.

Port numbering in examples

The port numbers in this document are for illustration only and might be unavailable on your device.

21



Appendix A Chassis views and technical
specifications

Chassis views

1920-8G

Figure 24 1920-8G front panel

(1) 10/100/1000BASE-T copper ports (2) 100/1000BASE-X SFP fiber ports
(3) Console port (4) Fiber port LEDs
(5) Copper port LEDs (6) Power LED

Figure 25 1920-8G rear panel

100-2 OVAC

o O (3]

(1) Grounding screw (2) AC power receptacle

(3) Security slot

1920-16G

Figure 26 1920-16G front panel

(1) 10/100/1000BASE-T copper ports (2) 100/1000BASE-X SFP fiber ports
(3) Fiber port LEDs (4) Copper port LEDs
(5) Power LED (6) Console port

22



Figure 27 1920-16G rear panel

O 0

(1) Grounding screw (2) AC power receptacle

1920-24G

Figure 28 1920-24G front panel

(1) 10/100/1000BASE-T copper ports (2) 100/1000BASE-X SFP fiber ports
(3) Fiber port LEDs (4) Copper port LEDs
(5) Power LED (6) Console port

Figure 29 1920-24G rear panel

(1 2

(1) Grounding screw (2) AC power receptacle

1920-48G

Figure 30 1920-48G front panel

(1) 10/100/1000BASE-T copper ports (2) 100/1000BASE-X SFP fiber ports

(3) Console port (4) Power LED
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Figure 31 1920-48G rear panel

5 ©
Bl
i

o 0

|

(1) Grounding screw (2) AC power receptacle

1920-8G-PoE+ (65W)

Figure 32 1920-8G-PoE+ (65W) front panel

il
(1] (2] (3] 0 60
(1) 10/100/1000BASE-T copper ports (2) 100/1000BASE-X SFP fiber ports
(3) Console port (4) Fiber port LEDs
(5) Copper port LEDs (6) Power LED

Figure 33 1920-8G-PoE+ (65W) rear panel

o 0 (3]

(1) AC power receptacle (2) Grounding screw

(3) Security slot

1920-8G-PoE+ (180W)

Figure 34 1920-8G-PoE+ (180W) front panel

pe
|
(1] (2 ©
(1) 10/100/1000BASE-T copper ports (2) 100/1000BASE-X SFP fiber ports
(3) Console port (4) Fiber port LEDs
(5) Copper port LEDs (6) Power LED
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Figure 35 1920-8G-PoE+ (180W) rear panel

o 0 (3]

(1) AC power receptacle (2) Grounding screw

(3) Security slot

1920-24G-PoE+ (180W)

Figure 36 1920-24G-PoE+ (180W) front panel

(1) 10/100/1000BASE-T copper ports (2) 100/1000BASE-X SFP fiber ports
(3) Fiber port LEDs (4) Copper port LEDs
(5) Power LED (6) Console port

Figure 37 1920-24G-PoE+ (180W) rear panel
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|

®

)

1 I 2)

(1) Grounding screw (2) AC power receptacle

1920-24G-PoE+ (370W)

Figure 38 1920-24G-PoE+ (370W) front panel

(1) 10/100/1000BASE-T copper ports (2) 100/1000BASE-X SFP fiber ports
(3) Fiber port LEDs (4) Copper port LEDs
(5) Redundant power system (RPS) power LED (6) Power LED

(7) Console port
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Figure 39 1920-24G-PoE+ (370W) rear panel

(1) Grounding screw (2) AC power receptacle

(3) DC power receptacle

Physical specifications

Chassis dimensions and weights

Chassis Dimensions (H x W x D) Maximum weight
1920-8G 44 x 266 x 162 mm (1.73 x 10.47 x 6.38 in) 1 kg (2.20 Ib)
1920-16G 44 x 440 x 173 mm (1.73 x 17.32x 6.81in) 2.1 kg (4.63 Ib)
1920-24G 44 x 440 x 173 mm (1.73 x 17.32 x 6.81 in) 2.2 kg (4.85 Ib)
1920-8G-PoE+ (65W) 44 x 330 x 230 mm (1.73 x 12.99 x 9.06 in) 2.1 kg (4.63 Ib)
1920-8G-PoE+ (180W) 44 x 330 x 230 mm (1.73 x 12.99 x 9.06 in) 2.5 kg (5.51 Ib)
1920-24G-PoE+ (180W) 44 x 440 x 238 mm (1.73 x 17.32 x 9.37 in) 3.4 kg (7.50 Ib)
1920-24G-PoE+ (370W) 44 x 440 x 260 mm (1.73 x 17.32x 10.24 in) 4.0 kg (8.82 Ib)
1920-48G 44 x 440 x 238 mm (1.73 x 17.32x9.37 in) 3.4 kg (7.50 Ib)

Ports and interface card slots

. 10/100/1000Base-T 44/ 900Base-x SFP
Chassis Console ports auto-sensing Ethernet
ports
poris

1920-8G 1 8 2
1920-16G 1 16 4
1920-24G 1 24 4
1920-8G-PoE+ (180W) 1 8, PoE+ 2
1920-8GPoE+ (65W) 1 8, PoE+ 2
1920-24G-PoE+ (370W) 1 24, PoE+ 4
1920-24G-PoE+ (180W) 1 24, PoE+ 4
1920-48G 1 48 4
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Environmental specitications

Chassis Operating temperature Relative humidity

All chassis 0°C to 40°C (32°F to 104°F) 5% to 95%, noncondensing

Power specifications

AC input voltage specifications

Chassis Rated voltage range

All chassis 100 VAC to 240 VAC @ 50 Hz or 60 Hz

RPS DC input voltage specifications and RPS compatibility

Chassis RPS input rated voltage range

1920-24G-PoE+ (370W) -54 VDC to -57 VDC

Power consumption specitications for non-PoE switches

Chassis Minimum power consumption  Maximum power consumption
1920-8G 4 W 8.5W
1920-16G 57W 13 W
1920-24G 9.5 W 19 W
1920-48G 20 W 32 W

Power consumption specitications for PoE switches

. Maximum . . Maximum power
Maximum | Minimum .
Chassis PoE power PoE ports at  Total PoE power consumption
full 30 W output . (including total PoE
per port consumption
output output)
1920-8G-PoE+
(65W) 30W 2 65 W 6W 94 W
1920-8G-PoE+
(180W) 30 W 6 180 W 1TW 230 W
1920-24G-PoE+
(180W) 30 W 6 180 W 18 W 235W
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Maximum

Maximum power

Chassis Ill,:)t:llix":\‘:vr:r PoE ports at  Total PoE N::;zum consumption
P full 30 W output P . (including total PoE
per port consumption
output output)
370 W at

1200AC pCinput 13O WAAC 474 W at AC input
[TAV2AGRE 30w et 740 W et 834 W at RPS DC
(370W) 24 at RPS DC o 7watRes of

. RPS DC . input

input . DC input

input
Cooling system
Chassis Fixed fans
1920-8G
1920-8G-PoE+ (65W)
N/A

1920-16G
1920-24G
1920-48G 1
1920-8G-PoE+ (180W) ,
1920-24G-PoE+ (180W)
1920-24G-PoE+ (370W) 3
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Appendix B LEDs

Power LED

Table 5 Power LED description

Status Description

Steady green The switch is powered on and the power supply is operating correctly.
Flashing green The switch is powered on and is performing the self-test.

Off The switch is not powered on or the power supply is faulty.

Copper port LEDs

Link/ACT LEDs
Table 6 Link/ACT LED description

Status Description

Steady yellow A 10/100-Mbps link is present.

Flashing yellow The port is receiving or sending data at 10/100 Mbps.
Steady green A 1000-Mbps link is present.

Flashing green The port is receiving or sending data at 1000 Mbps.
Off No link is present.

PoE LEDs
Table 7 PoE LED description

Status Description

Steady yellow The port is supplying power correctly.
Flashing yellow The port is supplying power incorrectly.
Off The port is not supplying power.

Fiber port LEDs

Table 8 SFP port LED description

Status Description
Steady yellow A 100-Mbps link is present.
Flashing yellow The port is receiving or sending data at 100 Mbps.
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Status Description

Steady green A 1000-Mbps link is present.
Flashing green The port is receiving or sending data at 1000 Mbps.
Off No link is present.

RPS LED

Only the HP 1920-24G-PoE+ (370W) supports the RPS.
Table 9 RPS power LED description

Status Description
Steady green The RPS is supplying power correctly.
Off No RPS is used or the RPS is supplying power incorrectly.
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Appendix C Troubleshooting

Table 10 describes the troubleshooting methods for common issues that you might encounter while using
and managing the switch.

If a problem persists, contact HP Support.
Table 10 Troubleshooting methods

Symptom Troubleshooting method

1. Verity that the correct power source is used and the power cords
Power LED off are correctly connected.

2. Verify that the power source side provides power supply correctly.

1. Verify that the network cable is correctly connected to the network

LAN inferface LED off port of the switch.
interface o 2. Insertthe two ends of a network cable into two network ports of the

switch. If the port LEDs are off, replace the network cable.

1. Ping 127.0.0.1 to verify that TCP/IP has been installed.

2. Ping the management IP address of the switch to verify that the
management PC is connected to the switch. If not, perform the
following check:

o For local configuration, verify that the IP addresses of the
management PC and the switch are in the same subnet.

o For remote configuration, verify that the route from the

Unable to |og in to ihe Web infer{oce mGnGgemeni PC to the SW”Ch is reClCth'e.
of the HP 1920 switch 3. Identify the LED status to verify that the cables are connected
correctly.

4. Verify that the switch's port that connects to the management PC is
enabled and belongs to the management VLAN.

5. Verify that the Web browser is not configured with proxy or dial-up
connection.

6. Disable and then enable the local network after you complete local
network settings.
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